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INTRODUCTION

Welcome to the Crosscheck Networks CloudPort Service Simulation product. Crosscheck Networks
created the CloudPort product to address the full range of web services simulation and client diagnostics
features to compress the deployment lifecycle and allow parallel service and client development. With
point-and-click service simulation, client development can be performed in parallel to service
development and thus reduce the total project time.

Additional capabilities provide the means to validate the functional quality of the client requests, ensure
that requests follow corporate best practices. CloudPort provides the portable framework that allows
service simulations to be created and shared among team members to help ensure consistent
development practices and techniques.

CloudPort can be used as a means to reduce sharing of IT and network resources for trading partner
integration testing or new business unit integration. Simulations are portable which allows for integration
testing locally before requiring shared lab time, firewall accessibility, and ultimately production server
access.

Service Simulation

> % &
BE @ -

L L L
SIMULATION QUALITY

SOAP/XML/REST Endpoint Simulation » Concurrent connections » Best Practices
» MQ/JMS/EMS Queue Processing » Large File Streaming Module » WSDL/SOAP /XML Standards
+ Parallel Client/Service Development » High Transaction Throughput » WS-Security Standards
» Improve interoperability » Multiple simulations » Provide consistency for clients
» Portable - Deploy on VMware or Cloud » Policy throughput stats and trading partners
» Functional quality reports

Identity Token Generator, WS-Security, Native PKI, Runtime State Machine

Point-and-Click Test Generator, Custom WSDL Parser, Custom SOAP Generator, Governance Scanning Engine
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CloudPort Editions

CloudPort Enterprise Edition

Provides all the features of Standard Edition and adds Large File Streaming, IBM MQ, Tibco EMS, Oracle
JMS, and JBoss JMS messaging adaptors, and dynamic client-side simulation control enabling clients to
control Simulation Rules through special variables in headers or message content. Standard edition
enables live runtime simulation rule editing when simulation is active.

CloudPort Runtime Player (Free)

Saved CloudPort simulations can be played on an unlimited number of machines using the free runtime
player. This allows playing any simulation on any number of machines after the simulation project rules
have been defined and stored in a re-distributable CloudPort simulation project file (.ssp) using CloudPort
Platinum Edition, or CloudPort Standard Edition to author the simulation rules.

Canned simulations are provided for free for the following:
e Echo Service
e Fault Service
e Pre-Built Response Service

MINIMUM REQUIREMENTS

The following is a list of requirements for installing CloudPort Enterprise Edition

CloudPort is a .NET tool that runs on Windows only.

Operating Systems

Windows 8 32bit/64bit
Windows 7 32bit/4bit
Windows Server 2012
Windows Vista 32bit
Windows XP
Windows Server 2008
Windows 2003
Windows 2000

NOTES: CloudPort can be run on MAC and UNIX based systems through the use of a Virtual Machine
running a Windows OS or via WineHQ.

Systems Minimum Requirements

1GB RAM (Minimum)
1GHz CPU (Minimum)
250MB Free Disk Space
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.NET Framework

Additional Installation and Activation Requirements

Local Administrator rights - full access to registry

Network connectivity for activation (online via HTTPS or manual via email)
For more information on running CloudPort with Administrator rights see:
http://www.sevenforums.com/tutorials/11841-run-administrator.html

If you plan on heavy performance testing with CloudPort, please contact Crosscheck Networks support to
discuss recommended requirements.

INSTALLATION

The CloudPort installation is very straight forward. Simply run the EXE and follow the on-screen
instructions.

Important Notes

e When installing on Windows 7, be sure to launch the installer with the “Run as Administrator”
option. Right click on the EXE to find this option.

e If the instance of CloudPort will be used by multiple different user accounts on the same PC,

install into a shared directory (i.e. C:\Users\All Users\Programs\Crosscheck Networks) that all
users have full permissions to access.

LICENSING

Licenses that are installed directly on the machine where CloudPort is running are called instance
licenses. Instance licenses require activation when installed.

Licenses that are shared among any number of deployed CloudPort installations are called floating

licenses. Floating licenses are leased for a period of time when needed, and returned to the pool of
available licenses once the lease has expired.

Instance Based Licensing

IMPORTANT NOTE: Itis very important that the license activation be done with full Administrator
access. With Windows 7 this often means launching the product with the “Run as Administrator” option.

Instance based licensing uses license keys which are activated on the specific instance of the application.
An instance license is enabled based on activation of the license key.

To apply an instance license, go to the Registration->Install Instance License menu and enter your
user information as well as the license key provided to you.

| Crosscheck Networks CloudPort™ Enterprise Quick Start Guide v4.0



= License Activation

Thank you for choosing Crosscheck Networks SOAPSonar

You have N days remaining for your current license key.

To apply a new license key please enter the information below and press the Activate button.

An internet connection is required to activate your license key.

Name

Company

| |
| |
Email | |
| |

l Activate Key l l Use License Server l ’ Manual Activate l

Proxy Settings  Privacy Policy

Close

Internet License Activation

Once the information has been entered, press the Activate button to activate this license against the
Crosscheck Networks Activation server. If the license key has valid activations remaining, your license
will be enabled for this instance.

If you do not have internet access, refer to the Manual Activation steps shown in the Manual License
Activation section below.

Manual License Activation

If you do not have internet access to activate your license using the Crosscheck Networks Activation
server, then follow the steps below the manually activate your license instance.

1. Enter you name, company name, email, and key code in the fields provided.

2. Click on the “Manual Activate” button below the key code field. The manual activation dialog will
appear with your target license key to be activated. Please check this key to be sure it is the key
you intend to activate. Press the Next button

# Manual Activation

Enter License Key
P00100-HEXVEV-NDZ5V2-NQ4BEE-PFLF06-Q9V22T-753NBH

Crosscheck Networks CloudPort™ Enterprise Quick Start Guide v4.0 |
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3. The Manual activation code will be generated on the next screen. Copy the activation ID shown
(click the clipboard button) and email this ID to activate@crosschecknet.com

# Manual Activation

Click the dipboard icon below to copy the Activation ID. Email this Activation ID to
activate@crosschecknet.com. Wait for your activation code via email (you can return this
this activation wizard later once you receive your code)

[PO0100-HEXVEV-NDZ5V2-NQ4BEE-PFLF0G-QOV22T-753NBF][CAAT-026D]

[ <pev ][ meer J[ cancal |

4. Crosscheck Networks will return the Activation Code in an email. Enter the provided Activation
Code in the “Enter Activation Code” box

& Manual Activation E||§|fg|

Paste the Activation Code you received via email, then click the Activate button

[ < Prev I [ Activate I [ Cancel

5. Close and restart the product.

Floating Based Licensing

Floating Licenses use a license server to obtain a lease for a license key for a specified duration. The
Crosscheck Networks License Server is installed on some location within the network that can be
accessed by the individual CloudPort instances. The Crosscheck Networks License Server uses a
leasing model which does not require persistent network access to the licensing server, but rather only
access at the time the lease is granted. Once a lease is granted, the product instance will not need to
have a connection to the license server to use the leased license.
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GETTING STARTED
Launch Options

Choose “Build Simulation” to launch the CloudPort Policy Manager to build the rules for the simulation
and save the information in a simulation project file.

Choose “Capture Live Traffic” to launch the Crosscheck Proxy Traffic Capture tool to capture live traffic
requests and responses as well as timing. The captured transactions can be subsequently imported into
CloudPort for automatically created simulations from the captured data.

Choose “Run Simulation” to launch the CloudPort Server to run the project rules and listen on the network
for inbound client requests, or to a message queue for MQ or JMS simulations.

Crosscheck Networks CloudPort - Choose Launch Action =]

Build Simulation ive: Traffic Run Simulation

Note: If you are running the free runtime simulation player, there will be no launch option, it will
automatically launch into the simulation project selection dialog to run the simulation.

Building Simulations with the CloudPort Policy Manager

The CloudPort Policy Manager interface is used to create the simulation rules used by the runtime
simulation server when running simulations. The interface is broken down into 3 views: Project Editing,
Execution Monitoring, and Simulation Diagnostics.

Project Editing

Shows the options and settings for creating Network endpoint and ESB-based simulations. This is also
where document analysis such as WSDL Scoring, and building task rules or success criteria rules is
performed.

Execution Monitoring
Shows the options and settings to configure remote simulations.

Simulation Diagnhostics
Shows the reporting and logging for the previously run simulations.

Crosscheck Networks CloudPort™ Enterprise Quick Start Guide v4.0 |
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Simulation Types

CloudPort allows you to build WSDL based SOAP simulations from a source WSDL and schema,
document, or build any arbitrary XML or REST endpoint simulations using custom definitions. All defined
simulations are portable and stored in CloudPort project files that can then be run using the runtime
CloudPort simulation player.

SOAP Simulation Test Case

Point-and-click SOAP simulation is accomplished by simply loading a WSDL. The parsed WSDL and
Schema will be represented in the project tab and a simulator for each WSDL operation will be generated
automatically based on the schema. Additional settings and additional simulators can then be added for
custom business logic simulations. Simulator SOAP responses can be built using the proprietary
Crosscheck Networks SOAP generator which provides graphical representation of the schema for the
message where the SOAP document is subsequently generated automatically.

XML Simulation Test Case
An XML Simulation provides the means to import or create any custom request/response transaction
sequence. You can also combine XML Simulators with SOAP Simulators.

REST Simulation Test Case
A REST Simulation provides the means to define input headers to target the simulation rules.

WSDL Capture

To create a Web Services Simulation, a WSDL document provides the contract of information about the
expected structure of each request and response for the service to allow clients to build requests to
consume the services responses. CloudPort parses WSDL documents for service emulation and
exposes the new simulated service WSDL and schema on a new network listener port. When a WSDL is
captured, it becomes a new Project item in the project tree with various configuration options for the
simulation environment and creating one or more request/response simulators for each service operation.

Capture WSDL 5 @

Capturing a WSDL document will automatically build SOAP Simulators based on the settings enabled in
the File->Settings panel. You can capture a WSDL document using several supported methods,

including
e Drag-Drop — Drag and drop WSDL files from a file explorer directly into the project window
e File — Browse your file system for the WSDL to load
e HTTP — Fetch the WSDL using HTTP
e HTTPS - Fetch the WSDL using HTTPS
e HTTP Basic Auth — Fetch the WSDL using HTTP with Basic Authentication Credentials
e HTTPS Basic Auth - Fetch the WSDLs using HTTPS with Basic Authentication Credentials
e HTTPS X.509 Auth - Fetch the WSDLs using HTTPS and X.509 SSL Authentication
e Project — Load WSDLs previously saved to a project file

For http or https access, authentication options are provided using the “Authentication Options” button at
the right of the WSDL Location field. CloudPort supports both HTTP Basic Authentication and SSL X.509
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client authentication. SSL X.509 client authentication is supported through a fully integrated native PKI
management interface that allows you direct access to your windows certificates and private keys.
Simply select the certificate you want to use for SSL client cert from the list of X509s loaded on your local

machine.

Once the WSDL is captured and parsed, the WSDL project tree will show a graphical representation of
the WSDL contents. Each node in the WSDL project tree will show properties specific to the type of
object (i.e. Service, Operation, Simulator). When you select an item in the tree, the available options for
that item will appear on the right portion of the screen.

Crosscheck Networks CloudPort™ Enterprise Quick Start Guide v4.0 | 11



RUNNING SIMULATIONS

Simulations are run in a separate process and can be launched independently of the project console. A
project file contains the settings for the simulation and the project file can be launched through the Policy
Manager or via the launch options.

Run using the local Runtime Simulation Player

Launch from the Simulation menu

Cmssd'leckN orks - C|
File | Simulation | Toels Updates Registration Help

< Deploy Simulation ( Local )
Ed < . |uit0ring o] Simulation Diagnos
Q Deploy Simulation ( Remote )

B H @ &Sados - T @ =

Capture WSDL

Project Tree Custom Group

= training.asmx
i @2 Configuration Simulators
3 WS5DL Services

—’_' Training

Run Simulation from Launch Menu
Once a simulation project is built and saved, this can be run from the CloudPort Runtime Simulation
Player.

To run the simulation, simply select from a previously run simulation, or use the browse button to browse
to the location where the SMP simulation project file is stored.

CloudPort Runtime Simulation Player =]
The Simulation Player requires a project file with the simulation rules.
Please select a simulation project and click Ok to continue, or Cancel to quit.
Simulatien Frojects | Quick Simulation
Simulation Project File:
pI[=)
Name Last Accessed i
C:\FSSupport\Nordstrom\POC\ Training smp 01/31/2011 12:52:15 L
C:\Support\Atos'Atos Simulation. SMP 01/26/2011 16:28:35 3
C:\Tools\SOAP Simulator\bin‘projects'echo. smp 01/24/2011 21:534.17
C\zzz\MemoryTable SMP 01/23/2011 D0:41:47
Chzzz\sslsimulation.SMP 01/20/2011 15:36:43
C:\Support\CSC'\2011\Cloudport test project smp 01/18/2011 17:02:48
Runtime Simulation Player CA\Suppot\CSC\Heiko\Vocab\Schematron_faults_in_HL7-Macy smp 01/19/2011 D0:58:39
C\Support\CSCush 2 Test xslt2.smp 01/17/2011 22:08:22
C:\Support\CSC'201 1\Cloudport Test Project-MACY smp 01/17/2011 21:26:53
CAESSmnnrt IR\ ana i Tactina- 201 TastMatariale) Prisrt Glac\Cln AP AR R G-Smekea Tact emn 01/07/2071 D0-40-49 S
N P
4 CHECK \-) Start Simulation Player ‘ Cancel

Running Embedded Simulations
There are several types of simulations that can be run without any configuration rules required.
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CloudPort Runtime Simulation Player

The Simulation Player requires a project file with the simulation rules.
Please select a simulation project and dick Ok to continue, or Cancel to quit.

Simulation Projects | QU

[

Runtime Simulation Player

» — -
AACHECK &)  Start Simulation Player || Cancel |

Echo Service

This is an embedded service which will echo the request document back to the client. When running this
simulation type you will be prompted for the port to run the echo service on.

Static Response Service

This is an embedded service which takes a specified document and always returns this document back to
the client. When running this simulation type you will be prompted for the static response document and
for the port to run the echo service on.

Fault Service

This is an embedded service which takes a specified document and always returns this document back to
the client along with a 500 HTTP fault code. When running this simulation type you will be prompted for
the static response document and the port the run the service on.

Crosscheck Networks CloudPort™ Enterprise Quick Start Guide v4.0 |
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The Runtime Simulation Player
The simulation player will open in a separate window. Options within the player include the ability to see

the active policies, runtime charts, view runtime transactions, and the simulator settings.

Global Actions: 1§ T

Simulation  View  Mode

Updates  Registration  Help

@ Active
Policies
Runtime

Charts

n Transaction

- Viewer

= simulation
* Variables

£f -:J. Simulator
_‘-."! Settings

@ | Diagnostics - O ?’,
Simulation Project tem IP Port URI Simulation Tests
TrainingSoap 0000 5082  Araining.training asmoc’ 4
1| (1] *
Training

Listener Policy || Simulation Tests |

Listener IPs: 127.0.0.1 , 192.168.58.1 , 192.168.202.1 , 10.5.1.209
URI: http://127.0.0.1:9082/training/ training.asmx/

WSDL: hifp://127.( 9082 /training/training.asnoy' ?WSDL Eﬂ IE

Large File Streaming: OFF

& Stop Simulation

Simulation Test: Echo_1

Target: soap:Envelope[0\soap:Body[0[\Mns:Eche[0] Ful=: Exsts

Request Processing Response Processing
Request Tasks: 0 Response Tasks: O
Request Runtime Variables: 1 Response Runtime Variables: 0
Success Criteria Rules: 0 Response Attachments:

Siimulation Response Data: EI'

m

Simulation log: Ghzzz\Simulation_15.xml
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PROXY SERVER TRAFFIC CAPTURE TOOL

CloudPort includes a built in tool that works as either a forward or reverse proxy server to capture live
traffic. The captured traffic can later be replayed with either SOAPSonar or CloudPort.

1! Crosscheck Networks -

Caplure Mode:  [Reverse Proy (Inline Capturing of Data ) | Local Port: 8081 Start Proxy Recording

Remote Server: 127001 Server Port: 80
Encode requests and respenses for binary Content-Types (enables replay via SOAPSonar and CloudPort)  Configure Content Types Recording Off
#  Time Source Destination Request Size Response Size Transaction Time {ms)  URL

double-click on entry to view in popup window

View Docked Vertical o
Request Response
po B » i
= =
ol |
& &
] » « »

Capture Modes

Reverse Proxy ( Inline Capturing of Data)

e Specify a local port to listen on
e Specify the IP or DNS name of the remote server that CloudPort will send the traffic to
e Specify the port listening on the remote server

Captura Mode: | Reverse Prasy (Inine Capturing of Data ) +| Local Por: 2081 Start Proxy Recording

Remote Sever:  127.0.0.1 Server Pot: 80
Encode requests and responises for binary Cortent Types (enables replay via SOAPSonar and CloudPort)  Corfiqure Contert Types Recording OFf
||| #  Time Source Destination Request Size Response Size  Transaction Time fms)  URL |

HTTP Forward Proxy ( Browser with Proxy Settings Configured )
e Specify a local port to listen on

Capture Mode [H‘I‘rP Forward Proxy { Browser with Praxy Settings Corfigursd ) ¥ | Local Port: 8081

Encode requests and responises for binary Content-Types (enables replay via SOAPSonar and CloudPort)  Configure Content Types Recording Off
||| #  Time Source Destination Request Size Response Size  Transaction Time fms)  URL ||

Crosscheck Networks CloudPort™ Enterprise Quick Start Guide v4.0 | 15



	INTRODUCTION
	CloudPort Editions
	CloudPort Enterprise Edition
	CloudPort Runtime Player (Free)


	MINIMUM REQUIREMENTS
	Operating Systems
	Systems Minimum Requirements
	Additional Installation and Activation Requirements

	INSTALLATION
	Important Notes

	LICENSING
	Instance Based Licensing
	Internet License Activation
	Manual License Activation

	Floating Based Licensing

	GETTING STARTED
	Launch Options
	Building Simulations with the CloudPort Policy Manager
	Project Editing
	Execution Monitoring
	Simulation Diagnostics
	Simulation Types
	WSDL Capture

	RUNNING SIMULATIONS
	Run using the local Runtime Simulation Player
	Launch from the Simulation menu
	Run Simulation from Launch Menu

	Running Embedded Simulations
	Echo Service
	Static Response Service
	Fault Service

	The Runtime Simulation Player

	PROXY SERVER TRAFFIC CAPTURE TOOL
	Capture Modes
	Reverse Proxy ( Inline Capturing of Data )
	HTTP Forward Proxy ( Browser with Proxy Settings Configured )


